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	UNIT STANDARD 114076  :
Use computer technology to research a computer topic 

		SPECIFIC OUTCOME 1 



	Plan the research of a computer topic.



		ASSESSMENT CRITERION 1 



	1. The plan identifies the topic, objectives, and scope of the research. 



	ASSESSMENT CRITERION 2 



	2. The plan identifies the time to be taken for the research, the research methods to be used, and the sources of information to be used. 



	ASSESSMENT CRITERION 3 



	3. The plan identifies the target audience, presentation methods, and the computer applications to be used for the analysis of data and the presentation of the results of the research. 



	
	

		SPECIFIC OUTCOME 2 



	Conduct research of a computer topic using computer technology. 



	OUTCOME RANGE 



	Internet, Other computer applications. 



		ASSESSMENT CRITERION 1 



	1. The research conducted accumulates data according to the research plan. 



	ASSESSMENT CRITERION 2 



	2. The research conducted provides data analysis with conclusions. 



	ASSESSMENT CRITERION 3 



	3. The description of the analysis methods allows the validity of the analysis to be assessed. 



	ASSESSMENT CRITERION 4 



	4. Research progress is indicated at intervals by reports, according to the research plan. 



	ASSESSMENT CRITERION 5 



	5. The research conducted uses a computer application to analyse the research data. 



	
	

		SPECIFIC OUTCOME 3 



	Present the results of research of a computer topic using computer technology 



		ASSESSMENT CRITERION 1 



	1. The presentation is made using the computer application identified in the research plan. 



	ASSESSMENT CRITERION 2 



	2. The presentation communicates summarised research data and conclusions to the target audience. 
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[bookmark: _Toc360318308]Introduction to computer research

Since their inception, computers have been used by humans to solve a number of everyday problems. They do vast variety of jobs with tremendous speed and efficiency.  Computers have become indispensible when it comes to conducting researches. That is, the computer assists the researcher in all the stages of the research process i.e. from planning the research to storing and distribution of the research results. 
A research can be defines as a systematic investigative process employed to increase or revise current knowledge by discovering new facts. It is divided into two general categories: 
a) Basic research is inquiry aimed at increasing scientific knowledge, and

b) Applied research is effort aimed at using basic research for solving problems or developing new processes, products, or techniques. 

[bookmark: _Toc360318309]Lesson 1 – The research process

The different stages in the market research process will now be explained in detail.

1. Define the research objective: The first step to the research process is to define the research objective. At this stage, the researcher defines the problem that he or she is attempting to solve.  Here, the word problem does not have a negative meaning. It can mean a new opportunity. Exploratory research is one of the most common types of research used at the early stage of the investigative process. It is used to obtain a clear understanding of the situation or environment. Secondary data, previous research, discussion with decision makers, experience survey, interviews with industry experts, similar case studies, a review of existing background information are some techniques that will help the researcher at this stage of the research process. 

2. Selection of basic research method: After defining the problem and formulating the objectives, the researcher shall design the research. This determines the way that the company collects the data. Survey questionnaires, interview, and observations even secondary data studies are methods that can be used to gather the data. However the most common method is a survey questionnaire.

3. Sampling: “A sample is a subset from larger population”. Finding information about the characteristic of a population is an important objective for most types of market research. Information about the population could be achieved by taking a sample. Proper and good sampling has the same characteristic of the population as whole.

4. Data gathering: During this stage, the researcher collects data. It may be obtained by human observation or a survey questionnaire. It can be over the phone or by face-to-face interviews.
5. Data processing and analysing: After gathering the data, the information must be converted into language which is understandable for a wider audience. At this stage, the first step is editing and coding. The researcher checks the data for any minor mistakes and then “codes” the data.  Coding means recording, categorising, and interpreting the data. The second step in this process is to analyse the data.

6. Drawing conclusions and reporting: The final stage in the research process is reporting and drawing a conclusion. A market research report consists of a description and an interpretation of the research results, a conclusion and also an appropriate recommendation. The costs and risks associated with delivering any new product are high.  Some new products fail to achieve the objectives set. 

DIAGRAM: RESEARCH PROCESS
	[image: market-research-flow-chart]


SOURCE: http://www.brainmates.com.au/contributions/the-importance-of-market-research
[bookmark: _Toc360318310]Lesson 2 – Planning a research

The first step in a research, as mentioned earlier is to plan for the research.  The research plan is used as the road map to be followed when conducting the research. The research plan is important in that it;
· It clears some grey areas in any research.
·  It describes the target market for the researcher to go in better informed and prepared. 
· It lays out in simpler terms the objectives of the research and thus makes it easier for the researcher to deal with objectives clearly and precisely. 

Structure of a research plan
A research plan should contain the following elements:
1. Topic: this outlines the name of the research.

2. Background: In the background to the research plan, one would sketch a short history of the problem or opportunity to be researched, its causes, effects and symptoms.

3. Research scope: The scope of research is the areas covered in the research. This part of the research paper you will tell exactly what was done and where the information that was used specifically came from. The type of information that would be included in the scope of a research project would include;
· Facts and theories about the subject of the project. Depending on the subject, the scope can be large or small, as there are different materials available for different projects. 

· The limitations, also known as the bounds, are the cease of the scope of studies. 

· When enough information has been gathered from a scope of a study, the individual who is doing the project may "wrap up" the information once a conclusion can be formed. Projects with too much information may bore or overwhelm the audience and cause the project to be ineffective due to the lack of information retained. 

For example, the scope would be something such as person gathering information from children between the ages of five years of age to 18 years of age. The information could be used for several purposes, such as for school record keeping. The limitations of this study would include the decision to not gather information from students from college and up. The information for school record keeping would not include those who have already graduated high school; therefore, information collected from college students and beyond would be irrelevant. Every research project includes scopes and limitations of the material being researched. Without these two factors, the reports would be meaningless and drone on for a length of time, and would not benefit anyone in the long run.

4. Research objectives: There is need to translate' chosen area objectives into research objective. For example,  research objectives for new markets may be to:
· Identify a shortlist of markets to focus on
· Select a target market within each of these shortlisted markets to focus research and marketing efforts on
· Better understand the market environment 
· Identify the tariff and non-tariff barriers to success
· Identify your major competitors and the products they sell
· Understand what drives the customer to buy similar products
· Understand the importance of brands, pricing, quality, features, service, etc. to potential customers
· Identify intermediaries that could assist in entering the market place
· Identify the best way to market the products in the foreign marketplace

5. Target audience: This section of the research plan specifies the audience that the research is seeking to target. It covers who is the audience, where are they , current knowledge, educational qualifications, and expectations 

6. Research methodology: This part of the research plan which is quite important and will outline how one plans to carry out the marketing research. This part identifies the research methods and sources of information to be used. This shall be discussed in the next session.

7. Research budget: A statement of the resources needed for the research. This is very important as it would determine the scope modus operandi in the research. Whether or not the research is going to be done in a vast or small area depends on the budget.

8. Research schedule: The research schedule should indicate how long this research will take to complete and when the various outputs of the research can be expected. It acts as a guide to the researchers.

9. Data analysis and presentation: This section covers the data analysis tools that shall be used in the research, computer application or software to be used for presentation of data e.g power point, excel etc

10. Conclusion: The brief will end with a conclusion, summarising the purpose of the research and indicating that all of the outcomes generated by this brief will be compiled into a research report.

Research plan example
Below is an example of a market research plan 
	Market Research Plan
To: Research agencies chosen to submit a proposal
From: John Peterson, J.P Spices Ltd, market research manager
Date: 13 April 2009

Background
J.P Spices was established in South Africa in 1991 and has become a market leader in the supply of Indian spices and Olive oil to countries outside South Africa. It is particularly strong in Namibia, Botswana and Algeria. For more information, please refer to our enclosed annual report, promotional brochures and websites. Olive oil has been used in many applications in recent years. Olive oil is protective to the digestive tract. Externally it soothes dry skin. It helps to keep the heart healthy and regular use is shown to prevent a build-up of cholesterol in the arteries. Olive oil can be used in salads or sauces. It stores well and will keep for up to a year in the right conditions.

Project Rationale
In Namibia J.P Spices supplies its Olive Oil to restaurants but not to the general public. This is not the case in Botswana and Algeria, where J.P Spices has been selling to the mass market for several years. J.P Spices is now considering the possibility of offering the same quality olive oil that it currently supplies to restaurants to the general public in Namibia. The working name for this oil is ‘Domestoil’. The company now wishes to commission research to help decision – making. 

Objectives
We feel it is necessary to investigate customers’ attitudes towards the oils and brands in this sector. This research should aim to gain a clear understanding of customers’ perceptions and experiences. Their attitudes should be measured against relevant indicators. We suspect that the name ‘Domestoil’ may be confused with a bleach that has a similar name and we would like that aspect to be investigated. After numerous internal discussions, we have agreed that the overall objective is ‘to examine attitudes to the use of Olive Oil in the home’. 
This has been broken into the following sub-objectives:
· To examine how oils are used in domestic settings
· To gather reactions to Domestoil
· To determine promotional platforms that can be used to launch Domestoil
Possible methodology
The agency chosen for the research must have experience with foodstuffs. Furthermore, we expect both qualitative and quantitative capabilities because we expect to use both approaches.
Please consider existing olive oil users, rather than non-users, because that is our immediate target audience.

Data will be provided on all restaurants we serve directly and also wholesalers we supply. This will include restaurant or wholesaler name, address and telephone number; we do not wish to supply the names of individuals to avoid any possible complications with the Data Protection Act.

If it is useful we will also give access to our sales force. We have 30 full time sales support staff in Namibia. This number includes five sales managers and five deputy field managers. Their work will be extended somewhat because they will also take on domestic oils when launched. They are often very busy individuals and they travel extensively for work, so we would be pleased to set up meetings if that is helpful; many come together for monthly sales meetings at our head office. We will provide any support that may be required in contacting them. 

Targeted audience
The following are the target audience for the research senior management, marketing manager, product development manager, olive staff and advocate customers.

Reporting and presentational requirements
Following this brief, a research proposal will be required. We would be pleased to have a meeting to discuss this written brief; alternatively, please use email or the telephone to clarify any issues. A brief email describing your thinking would be most welcome. When the project is underway, we would like regular progress reports. At a suitable point during fieldwork, we would like an interim report and meeting. A formal presentation of the research findings to the board of directors will be required, supported by a final written report.

Timing
The project timeframe must respect the needs of the product launch and availability of sales staff involved. Important signpost dates include:
15 May 2009		Proposal deadlines
1 June 2009		Go – ahead given
End of October	Expected presentation date
November 2009	Annual sales conference (we would like you tom repeat the presentation at this)
May 2010		‘Domestoil’ launch expected

Budget
There is a set budget of R200 000 for this project, which cannot be exceeded. We expect the proposal to show a breakdown of direct costs and staff time. Please separate the distinct elements of your proposal in the event that budget constraints do not allow us commission your entire solution.

John Peterson






	
LEARNING ACTIVITY 1


You develop a research plan for the following topic:  The effects of computer technology in your community. Note, the plan must identify;
· Topic
· Objectives
· Scope of research
· Research methods
· Sources of information
· Target audience
· Presentation methods
· Computer applications to be used for analysis







[bookmark: _Toc360318311]Lesson 3 – Research Methods and sources

There are two main sources of market research information:
A. PRIMARY RESEARCH

This kind of research involves the collection of new information by conducting market surveys, telephonic interviews, questionnaires and focus group interviews. This information is gathered by directly contacting the customers. This research is customised according to the research requirements of the company. Firms can gain insights about the target markets by means of focus groups, surveys, interviews or observation. Primary research is generally based on sampling techniques and requires statistical methodologies. The sample size could be as small as 1 percent of the market and thus the information and results gathered are highly accurate. Primary research examples will now be discussed in detail.
1. Interviews
Interviews are among the most challenging and rewarding forms of measurement. They require a personal sensitivity and adaptability as well as the ability to stay within the bounds of the designed protocol. Below is a description of the preparation one need to do for an interview study and the process of conducting the interview itself.
The interviewer is really the "jack-of-all-trades" in survey research. The interviewer's role is complex and multifaceted. It includes the following tasks:
a) Locate and enlist cooperation of respondents: The interviewer has to find the respondent. In door-to-door surveys, this means being able to locate specific addresses. Often, the interviewer has to work at the least desirable times (like immediately after dinner or on weekends) because that's when respondents are most readily available.

b) Motivate respondents to do good job: If the interviewer does not take the work seriously, why would the respondent? The interviewer has to be motivated and has to be able to communicate that motivation to the respondent. Often, this means that the interviewer has to be convinced of the importance of the research.

c) Clarify any confusion/concerns: Interviewers have to be able to think on their feet. Respondents may raise objections or concerns that were not anticipated. The interviewer has to be able to respond candidly and informatively.

d) Observe quality of responses: Whether the interview is personal or over the phone, the interviewer is in the best position to judge the quality of the information that is being received. Even a verbatim transcript will not adequately convey how seriously the respondent took the task, or any gestures or body languages that were evident.

e) Conduct a good interview: Last, and certainly not least, the interviewer has to conduct a good interview! Every interview has a life of its own. Some respondents are motivated and attentive, others are distracted or disinterested. The interviewer also has good or bad days. Assuring a consistently high-quality interview is a challenge that requires constant effort.
2. Questionnaires 
Questionnaires are an inexpensive way to gather data from a potentially large number of respondents. Often they are the only feasible way to reach a number of reviewers large enough to allow statistically analysis of the results. A well-designed questionnaire that is used effectively can gather information on both the overall performance of the test system as well as information on specific components of the system. If the questionnaire includes demographic questions on the participants, they can be used to correlate performance and satisfaction with the test system among different groups of users. 
It is important to remember that a questionnaire should be viewed as a multi-stage process beginning with definition of the aspects to be examined and ending with interpretation of the results. Every step needs to be designed carefully because the final results are only as good as the weakest link in the questionnaire process. 
Although questionnaires may be cheap to administer compared to other data collection methods, they are every bit as expensive in terms of design time and interpretation. The steps required to design and administer a questionnaire include: 
1. Defining the Objectives of the survey 
2. Determining the Sampling Group 
3. Writing the Questionnaire 
4. Administering the Questionnaire 
5. Interpretation of the Results
This document will concentrate on how to formulate objectives and write the questionnaire. Before these steps are examined in detail, it is good to consider what questionnaires are good at measuring and when it is appropriate to use questionnaires.
NOTE: Questionnaires are quite flexible in what they can measure, however they are not equally suited to measuring all types of data. We can classify data in two ways, Subjective vs. Objective and Quantitative vs. Qualitative. 
When a questionnaire is administered, the researchers control over the environment will be somewhat limited. This is why questionnaires are inexpensive to administer. This loss of control means the validity of the results are more reliant on the honesty of the respondent. Consequently, it is more difficult to claim complete objectivity with questionnaire data then with results of a tightly controlled lab test. For example, if a group of participants are asked on a questionnaire how long it took them to learn a particular function on a piece of software, it is likely that they will be biased towards themselves and answer, on average, with a lower than actual time. A more objective usability test of the same function with a similar group of participants may return a significantly higher learning time. More elaborate questionnaire design or administration may provide slightly better objective data, but the cost of such a questionnaire can be much higher and offset their economic advantage. In general, questionnaires are better suited to gathering reliable subjective measures, such as user satisfaction, of the system or interface in question. 
Questions may be designed to gather either qualitative or quantitative data. By their very nature, quantitative questions are more exact then qualitative. For example, the word "easy" and "difficult" can mean radically different things to different people. Any question must be carefully crafted, but in particular questions that assess a qualitative measure must be phrased to avoid ambiguity. Qualitative questions may also require more thought on the part of the participant and may cause them to become bored with the questionnaire sooner. In general, we can say that questionnaires can measure both qualitative and quantitative data well, but that qualitative questions require more care in design, administration, and interpretation. 

NOTE: There is no all encompassing rule for when to use a questionnaire. The choice will be made based on a variety of factors including the type of information to be gathered and the available resources for the experiment. A questionnaire should be considered in the following circumstances. 

a. When resources and money are limited. A Questionnaire can be quite inexpensive to administer. Although preparation may be costly, any data collection scheme will have similar preparation expenses. The administration cost per person of a questionnaire can be as low as postage and a few photocopies. Time is also an important resource that questionnaires can maximise. If a questionnaire is self-administering, such as a e-mail questionnaire, potentially several thousand people could respond in a few days. It would be impossible to get a similar number of usability tests completed in the same short time.

b. When it is necessary to protect the privacy of the participants. Questionnaires are easy to administer confidentially. Often confidentiality is the necessary to ensure participants will respond honestly if at all. Examples of such cases would include studies that need to ask embarrassing questions about private or personal behaviour. 

c. When corroborating other findings. In studies that have resources to pursue other data collection strategies, questionnaires can be a useful confirmation tools. 
More costly schemes may turn up interesting trends, but occasionally there will not be resources to run these other tests on large enough participant groups to make the results statistically significant. A follow-up large scale questionnaire may be necessary to corroborate these earlier results.


3. Focus Groups
A focus group is a form of qualitative research in which a group of people are asked about their perceptions, opinions, beliefs and attitudes towards a product, service, concept, advertisement, idea, or packaging. Questions are asked in an interactive group setting where participants are free to talk with other group members. The first focus groups were created at the Bureau of Applied Social Research in the USA, by associate director, sociologist Robert K. Merton. The term itself was coined by psychologist and marketing expert Ernest Dichter. 
In the world of marketing, focus groups are seen as an important tool for acquiring feedback regarding new products, as well as various topics. In particular, focus groups allow companies wishing to develop, package, name, or test market a new product, to discuss, view, and/or test the new product before it is made available to the public. This can provide invaluable information about the potential market acceptance of the product.
Focus Group is an interview, conducted by a trained moderator among a small group of respondents. The interview is conducted in an unstructured and natural way where respondents are free to give views from any aspect.
B: SECONDARY RESEARCH
Secondary research involves processing data that has already been collected by previous researchers. It refers to consultation of previous studies and findings such as reports, press articles and previous market research projects in order to come to a conclusion. This type of research is based on information gathered from studies previously performed by government agencies, trade associations, and other organisations. 
This type of research is less expensive as opposed to the primary research as it does not require new research methods. However, its main disadvantage is that the information gathered may be old and obsolete and therefore results of analysis may be inaccurate. Further, it is not necessary that the earlier studies were conducted with the same objectives as required in the current situation.
The quality of the research relies on quality of information collected. Information about the markets can be obtained from different sources.  Here are some sources where you can collect market information for the research purposes:
· Business magazines. Business magazines are a valuable source of business information that can be useful in purpose of research. There you can find already finished analysis that can be valuable for your business. There you can find information about your customers, your competitor or different marketing campaigns in the industry.
· Journals
· Newspaper articles
· Textbooks and books
· Blogs
· Websites etc

[bookmark: _Toc360318312]Lesson 4 – Data collection techniques
Data-collection techniques allow us to systematically collect information about our objects of study (people, objects, phenomena) and about the settings in which they occur.
In the collection of data we have to be systematic. If data are collected haphazardly, it will be difficult to answer our research questions in a conclusive way.
	Example:
During a nutrition survey three different weighing scales were used in three villages. The researchers did not record which scales were used in which village. After completion of the survey it was discovered that the scales were not standardised and indicated different weights when weighing the same child. It was therefore impossible to conclude in which village malnutrition was most prevalent.




Various data collection techniques can be used such as:
· Using available information
· Observing
· Interviewing (face-to-face)
· Administering written questionnaires
· Focus group discussions
· Projective techniques, mapping, scaling
1. Using available information
Usually there is a large amount of data that has already been collected by others, although it may not necessarily have been analysed or published. Locating these sources and retrieving the information is a good starting point in any data collection effort.
For example, analysis of the information routinely collected by health facilities can be very useful for identifying problems in certain interventions or in flows of drug supply, or for identifying increases in the incidence of certain diseases.
Analysis of health information system data, census data, unpublished reports and publications in archives and libraries or in offices at the various levels of health and health-related services, may be a study in itself. Usually, however, it forms part of a study in which other data collection techniques are also used.
The use of key informants is another important technique to gain access to available information. Key informants could be knowledgeable community leaders or health staff at various levels and one or two informative members of the target group (e.g., adolescents on their sexual behaviour). They can be involved in various stages of the research, from the statement of the problem to analysis of the data and development of recommendations. Other sources of available data are newspapers and published case histories, e.g., patients suffering from serious diseases, or their relatives, telling their experiences and how they cope.*
Note:
In order to retrieve the data from available sources, the researcher will have to design an instrument such as a checklist or compilation sheet. In designing such instruments, it is important to inspect the layout of the source documents from which the data is to be extracted. For health information system (HIS) data, for example, the data compilation sheet should be designed in such a way that the items of data can be transferred in the order in which the items appear in the source document. This will save time and reduce error.
The advantage of using existing data is that collection is inexpensive. However, it is sometimes difficult to gain access to the records or reports required, and the data may not always be complete and precise enough, or too disorganised.
2. Observing
OBSERVATION is a technique that involves systematically selecting, watching and recording behaviour and characteristics of living beings, objects or phenomena.
Observation of human behaviour is a much-used data collection technique. It can be undertaken in different ways:
· Participant observation: The observer takes part in the situation he or she observes.
(For example, a doctor hospitalised with a broken hip, who now observes hospital procedures ‘from within’.)
· Non-participant observation: The observer watches the situation, openly or concealed, but does not participate.
Observations can be open (e.g., ‘shadowing’ a health worker with his/her permission during routine activities) or concealed (e.g., ‘mystery clients’ trying to obtain antibiotics without medical prescription). They may serve different purposes. Observations can give additional, more accurate information on behaviour of people than interviews or questionnaires. They can also check on the information collected through interviews especially on sensitive topics such as alcohol or drug use, or stigmatising diseases. For example, whether community members share drinks or food with patients suffering from feared diseases (leprosy, TB, AIDS) are essential observations in a study on stigma.
Observations of human behaviour can form part of any type of study, but as they are time consuming they are most often used in small-scale studies.
Observations can also be made on objects. For example, the presence or absence of a latrine and its state of cleanliness may be observed. Here observation would be the major research technique.
If observations are made using a defined scale they may be called measurements. Measurements usually require additional tools. For example, in nutritional surveillance we measure weight and height by using weighing scales and a measuring board. We use thermometers for measuring body temperature.
3. Interviewing
An INTERVIEW is a data-collection technique that involves oral questioning of respondents, either individually or as a group.
Answers to the questions posed during an interview can be recorded by writing them down (either during the interview itself or immediately after the interview) or by tape-recording the responses, or by a combination of both.
Interviews can be conducted with varying degrees of flexibility. The two extremes, high and low degree of flexibility, are described below:
• High degree of flexibility:
	For example:
When studying sensitive issues such as teenage pregnancy and abortions, the investigator may use a list of topics rather than fixed questions. These may, e.g., include how teenagers started sexual intercourse, the responsibility girls and their partners take to prevent pregnancy (if at all), and the actions they take in the event of unwanted pregnancies. The investigator should have an additional list of topics ready when the respondent falls silent, (e.g., when asked about abortion methods used, who made the decision and who paid). The sequence of topics should be determined by the flow of discussion. It is often possible to come back to a topic discussed earlier in a later stage of the interview.




The unstructured or loosely structured method of asking questions can be used for interviewing individuals as well as groups of key informants.
A flexible method of interviewing is useful if a researcher has as yet little understanding of the problem or situation he is investigating, or if the topic is sensitive. It is frequently applied in exploratory studies. The instrument used may be called an interview guide or interview schedule.*
• Low degree of flexibility:
Less flexible methods of interviewing are useful when the researcher is relatively knowledgeable about expected answers or when the number of respondents being interviewed is relatively large. Then questionnaires may be used with a fixed list of questions in a standard sequence, which have mainly fixed or pre-categorised answers.
For example:
After a number of observations on the (hygienic) behaviour of women drawing water at a well and some key informant interviews on the use and maintenance of the wells, one may conduct a larger survey on water use and satisfaction with the quantity and quality of the water.
* Though in principle one may speak of loosely structured questionnaires, in practice the term questionnaire appears to be so hooked to tools with pre-categorised answers that we have decided to use the term interview guide for loosely structured tools. However, in reality there is often a mixture of open and pre-categorised answers (see Module 10B). In that case we will still use the term questionnaire.
4. Administering written questionnaires
A WRITTEN QUESTIONNAIRE (also referred to as self-administered questionnaire) is a data collection tool in which written questions are presented that are to be answered by the respondents in written form.
A written questionnaire can be administered in different ways, such as by:
· Sending questionnaires by mail with clear instructions on how to answer the questions and asking for mailed responses;
· Gathering all or part of the respondents in one place at one time, giving oral or written instructions, and letting the respondents fill out the questionnaires; or
· Hand-delivering questionnaires to respondents and collecting them later.
The questions can be either open-ended or closed (with pre-categorised answers). 
5. Focus group discussions (FGD)
A focus group discussion allows a group of 8 - 12 informants to freely discuss a certain subject with the guidance of a facilitator or reporter. (See Module 10C for a discussion of this technique.)
6. Projective techniques
When a researcher uses projective techniques, (s)he asks an informant to react to some kind of visual or verbal stimulus.
For example: An informant may be provided with a rough outline of the body and be asked to draw her or his perception of the conception or onset of an illness.
Another example of a projective technique is the presentation of a hypothetical question or an incomplete sentence or case/study to an informant (‘story with a gap’). A researcher may ask the informant to complete in writing sentences such as:
· If I were to discover that my neighbour had TB, I would . . .;
· If my wife were to propose that I use condoms, I would . . .
Or (s)he may ask the informant: Suppose your child suffered from diarrhoea, what would you do?
Such techniques can easily be combined with semi-structured interviews or written questionnaires. They are also very useful in FGDs to get people’s opinion on sensitive issues.
7. Mapping and scaling
Mapping is a valuable technique for visually displaying relationships and resources.
In a water supply project, for example, mapping is invaluable. It can be used to present the placement of wells, distance of the homes from the wells, other water systems, etc. It gives researchers a good overview of the physical situation and may help to highlight relationships hitherto unrecognized.
Mapping a community is also very useful and often indispensable as a pre-stage to sampling.
Scaling is a technique that allows researchers through their respondents to categorise certain variables that they would not be able to rank themselves.
	For example, they may ask their informant(s) to bring certain types of herbal medicine and ask them to arrange these into piles according to their usefulness. The informants would then be asked to explain the logic of their ranking.



Mapping and scaling may be used as participatory techniques in rapid appraisals or situation analyses. In a separate volume on participatory action research, more such techniques will be presented. (Also see the literature list at end of this module.)
Rapid appraisal techniques and participatory research are approaches often used in health systems research.



[bookmark: _Toc360318313]Lesson 5 – Using the internet for research

There are many ways to locate information on the Internet. Common strategies for finding and using information on the Internet include 
· Going Directly to a Known Site 
· Looking Locally 
· Using Internet Directories 
· Using Search Engines 
· Using Internet Bibliographies 
· Asking Online Groups

Once you have located information on the Internet, you will need to evaluate it for accuracy and relevance. If you use the resource in a document, you will need to cite the resource in a bibliography.
1. [bookmark: Going_Directly_to_a_Known]Going Directly to a Known Site: If a logical source for information can be identified, go directly to that web site.  If the web address of the site not known, make an educated guess as to the address.  Web addresses of companies are often formatted as www.companyname.com (e.g., www.microsoft.com).  University web addresses are typically formatted as www.universityname or acronym.edu (e.g., www.ilstu.edu or www.iwu.edu).  Likewise, government agency addresses are typically formatted as www.agency name acronym.gov (e.g., www.hud.gov or www.doj.gov).

2. [bookmark: Looking_Locally]Looking Locally: Librarians usually collect and evaluate useful resources in their areas of subject expertise. These resources can be found by selecting the "Specific Subjects" category under Resources by Subject on the Library web site.  Many campus departments have also collected useful web sites in their area. Check their sites under Academics.
[bookmark: Using_Internet_Directories]
3. Using Internet Directories: Directories are best used for locating major resources on a topic and for more general types of research.  Internet directories allow you to navigate through hierarchical subject menus to locate relevant resources. An advantage to using an Internet directory is that the sites are selected and categorized by humans. Once indexed, sites included in a directory are retrieved with a search engine.  Directories typically index only the main (or home) pages of web sites rather than all of the pages of the sites.  Listed below are some Internet directories selected on the basis of frequency of use, positive user reviews, and unique features.  
· INFOMINE
· Open Project Directory
· Internet Scout Project
· WWW Virtual Library
Librarians' Index to the Internet
· Yahoo
looksmart


4. [bookmark: Using_Search_Engines]Using Search Engines: Search engines are best used for information that does not fit into one category and for more specific types of research (e.g., a search for a specific fact or name).  A single index to the Internet does not exist.  Search engines offer different ways of locating information on the Internet.   Listed below are some search engines selected on the basis of frequency of use, positive user reviews, and unique features.  
· Google
· alltheweb (Fast)
· excite
AltaVista
· AOL Search
· HotBot
AskJeeves
· Lycos/LycosPro

Meta search engines use more than one search engine to conduct web searches. The various engines are used simultaneously or in succession.  Recognizing that no one search engine indexes the entire Internet, meta search engines are useful when trying to find as much information on the Internet about a specific topic as possible.  
· CNET
· MetaCrawler
Dogpile
· ProFusion
ixquick
· Vivisimo
· Mamma

5. [bookmark: Using_Internet_Bibliographies]Using Internet Bibliographies: Online lists of selected Internet resources are available on virtually every topic imaginable.  Argus Clearinghouse is a large collection of Internet bibliographies. Most guides listed at this site are available in hypertext versions. C&RL NewsNet Internet Resources list bibliographies written by librarians and published monthly in C&RL News. All guides listed at this site are available in hypertext versions. WebWatch lists web bibliographies compiled by librarians and published monthly in Library Journal. 

6. [bookmark: Asking_Online_Groups]Asking Online Groups: Listservs and newsgroups are good places to see information online from other individuals.  While the terms are often used interchangeably, they technically represent different venues. 
· Listservs (also called mailing lists) are topic-specific forums.  Software underlying the system maintains a list of email addresses to which messages are sent.  Listservs generally require a subscription to the list before messages can be received. 

· Newsgroups (also called UseNet or network news) are discussion groups that operate similar to electronic bulletin boards.  Newsgroup messages are distributed to computer sites and can be accessed and read using a newsreader or a web browser.  The messages are not sent to individuals directly via e-mail as they are in Listservs.  Messages posted to a newsgroup are typically organized by topic and archived for future access. 
The FAQ file associated with each listserv or newsgroup typically includes important information about participating in the group.  Netiquette suggests that new users consult these FAQ files rather than post questions regarding group operation directly to the list or bulletin board.  A popular directory of online discussion and news groups is Google Groups. 

	
LEARNING ACTIVITY 2


You are now required to conduct a research on the effects of computer technology in your community. Follow your research plan and ensure that,  
· You gather all relevant data 
· Your research provides data analysis with conclusions
· Use analysis methods that allows the validity of the analysis to be assessed
· Write reports to indicate the progress of your research
· Use computer applications (for example, MS Excel 2010 and MS Word 2010) to analyse your research data. 










[bookmark: _Toc360318314]Lesson 6 – Data processing

Data processing is crucial to any research program even the best-designed questionnaire cannot make up for data that is incorrect or incomplete. The amount of data that is generated in the various industries could be overwhelming for the organisations to manage. This is where data processing comes into the picture. By implementing data processing techniques, the data that are generated can be organised, presented and made readily accessible.

· Data processing is the act of handling or manipulating data in some fashion. Regardless of the activities involved in it, processing tries to assign meaning to data.  Thus, the ultimate goal of processing is to transform data into information. Data processing is the process through which facts and figures are collected, assigned meaning, communicated to others and retained for future use.  Hence we can define data processing as a series of actions or operations that converts data into useful information.  We use the term 'data processing system' to include the resources that are used to accomplish the processing of data.

· Market research data processing can refer to different aspects of the entire market research analysis process. Most often, data processing and data cleaning are used interchangeably.

Occasionally, a respondent to your survey does not really know the answer to a survey question (and just guesses) or simply makes a mistake in answering, or would just rather not answer the question (make sure you put in a "don't know" category for the respondent to default to). 


	Example

For example, suppose a survey question asks how many children live in the household. Instead of typing in a "2", the respondent (or the interviewer) slips and types in "22" accidentally. Now, it might be possible for 22 children to be living in a house (not a house we would want to live in!), but we can probably assume that this was a mistake. Since we don't know the correct response for certain, we would change the response for that respondent from "22" to "missing." That way, this answer is not counted as part of the statistics generated for this question.

If we do not "clean" this market research data, when we calculated the average number of children living in respondents' houses, the number would be inflated. That could easily cause the researcher to make an incorrect conclusion based on the data. By "cleaning" the data, those responses would be "corrected," and the statistical software you are using (or spreadsheet or whatever) would not include that response in the analysis.




· The good thing is that you don’t have to go through every response from every respondent to clean the data. You can generate (or have a professional analyst produce for you) what is called a frequency table or "freqs." A freq is simply a count of each response category for each question in the survey. So, in the example above, the freq would list the response category of 0 and the number of respondents who gave that answer. It would do so for all responses to the question. You can easily go through the freq to see what answers just out as mistakes. You "clean" them in the dataset and presto, you are ready to analyse your market research data.

 DATA PROCESSING ACTIVITIES
Man has in course of time devised certain tools to help him in processing data.  These include;
· Manual tools such as pencil and paper
· mechanical tools such as filing cabinets
· Electromechanical tools such as adding machines and typewriters, and 
· Electronic tools such as calculators and computers.  

Many people immediately associate data processing with computers.  As stated above, a computer is not the only tool used for data processing; it can be done without computers also.  However, computers have outperformed people for certain tasks.  There are some other tasks for which computers are a poor substitute for human skill and intelligence.

Regardless to the type of equipment/tool used, various functions and activities which need to be performed for data processing can be grouped under five basic categories as shown in the Diagram below

DIAGRAM: DATA PROCESSING ACTIVITIES
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Let’s describe each of these activities.

a. Collection: Data originates in the form of events transaction or some observations. This data is then recorded in some usable form.  Data may be initially recorded on paper source documents and then converted into a machine usable form for processing.  Alternatively, data may be recorded by a direct input device in a paperless, machine-readable form.  Data collection is also termed as data capture.

b. Conversion: Once the data is collected, it is converted from its source documents to a form that is more suitable for processing.  The data is first codified by assigning identification codes.  A code comprises of numbers, letters, special characters, or a combination of these.  For example, an employee may be allotted a code as 52-53-162, his category as A class and so on.  It is useful to codify data, when data requires classification.  To classify means to categorise, that is, data with similar characteristics are placed in similar categories or groups. For example, one may like to arrange accounts data according to account number or date.  After classification of data, it is verified or checked to ensure the accuracy before processing starts. After verification, the data is transcribed from one data medium to another.  For example, in case data processing is done using a computer, the data may be transformed from source documents to machine sensible form using magnetic tape or a disk.

c. Manipulation: Once data is collected and converted, it is ready for the manipulation function which converts data into information.  Manipulation consists of following activities:
i. Sorting: It involves the arrangement of data items in a desired sequence. Usually, it is easier to work with data if it is arranged in a logical sequence.  Most often, the data is arranged in alphabetical sequence.  Sometimes sorting itself will transform data into information.  For example, a simple act of sorting the names in alphabetical order gives meaning to a telephone directory.  The directory will be practically worthless without sorting. Business data processing extensively utilises sorting technique.  Virtually all the records in business files are maintained in some logical sequence. Numeric sorting is common in computer-based processing systems because it is usually faster than alphabetical sorting. 
ii. Calculating: Arithmetic manipulation of data is called calculating.  Items of recorded data can be added to one another, subtracted, divided or multiplied to create new data. Calculation is an integral part of data processing.  For example, in calculating an employee's pay, the hours worked multiplied by the hourly wage rate gives the gross pay.  Based on total earning, income-tax deductions are computed and subtracted from gross-pay to arrive at net pay.
iii. Summarising: To summarise is to condense or reduce masses of data to a more usable and concise form. For example, you may summarise Research findings by writing small notes in one or two pages. When the data involved is numbers, you summarise by counting or accumulating the totals of the data in a classification or by selecting strategic data from the mass of data being processed.  
iv. Comparing: To compare data is to perform an evaluation in relation to some known measure. For example, business managers compare data to discover how well their companies are doing.  They many compare current sales figures with those for last year to analyse the performance of the company in the current month.
d. Managing the Output Results: Once data has been captured and manipulated following activities may be carried out :
i. Storing: To store is to hold data for continued or later use. Storage is essential for any organised method of processing and re-using data.  The storage mechanisms for data processing systems are file cabinets in a manual system, and electronic devices such as magnetic disks/magnetic tapes in case of computer based system.  The storing activity involves storing data and information in organised manner in order to facilitate the retrieval activity.  Of course, data should be stored only if the value of having them in future exceeds the storage cost.
ii. Retrieving: To retrieve means to recover or find again the stored data or information. Retrieval techniques use data storage devices.  Thus data, whether in file cabinets or in computers can be recalled for further processing.  Retrieval and comparison of old data gives meaning to current information.
e. Communication: Communication is the process of sharing information.  Unless the information is made available to the users who need it, it is worthless. Thus, communication involves the transfer of data and information produced by the data processing system to the prospective users of such information or to another data processing system.  As a result, reports and documents are prepared and delivered to the users.  In electronic data processing, results are communicated through display units or terminals.

f. Reproduction: To reproduce is to copy or duplicate data or information.  This reproduction activity may be done by hand or by machine.

Activity
What are some of the things you need to put into consideration when using the internet to conduct a research?


[bookmark: _Toc360318315]Lesson 7 – Analysing and interpreting information

When analyzing data (whether from questionnaires, interviews, focus groups, or whatever), always start from review of your research goals, i.e., the reason you undertook the research in the first place. This will help you organize your data and focus your analysis. 
	For example, 
· If you wanted to improve a program by identifying its strengths and weaknesses, you can organize data into program strengths, weaknesses and suggestions to improve the program. 

· If you wanted to fully understand how your program works, you could organize data in the chronological order in which customers or clients go through your program. 

· If you are conducting a performance improvement study, you can categorize data according to each measure associated with each overall performance result, e.g., employee learning, productivity and results.




Basic analysis of "quantitative" information
(for information other than commentary, e.g., ratings, rankings, yes's, no's, etc.):
1. Make copies of your data and store the master copy away. Use the copy for making edits, cutting and pasting, etc.
2. Tabulate the information, i.e., add up the number of ratings, rankings, yes's, no's for each question.
3. For ratings and rankings, consider computing a mean, or average, for each question. For example, "For question #1, the average ranking was 2.4". This is more meaningful than indicating, e.g., how many respondents ranked 1, 2, or 3.
4. Consider conveying the range of answers, e.g., 20 people ranked "1", 30 ranked "2", and 20 people ranked "3".
Basic analysis of "qualitative" information
1. Read through all the data.
2. Organize comments into similar categories, e.g., concerns, suggestions, strengths, weaknesses, similar experiences, program inputs, recommendations, outputs, outcome indicators, etc.
3. Label the categories or themes, e.g., concerns, suggestions, etc.
4. Attempt to identify patterns, or associations and causal relationships in the themes, e.g., all people who attended programs in the evening had similar concerns, most people came from the same geographic area, most people were in the same salary range, what processes or events respondents experience during the program, etc.
5. Keep all commentary for several years after completion in case needed for future reference.
Interpreting information
1. Attempt to put the information in perspective, e.g., compare results to what you expected, promised results; management or program staff; any common standards for your products or services; original goals (especially if you are conducting a program evaluation); indications or measures of accomplishing outcomes or results (especially if you are conducting an outcomes or performance evaluation); description of the program's experiences, strengths, weaknesses, etc. (especially if you're conducting a process evaluation).
2. Consider recommendations to help employees improve the program, product or service; conclusions about program operations or meeting goals, etc.
3. Record conclusions and recommendations in a report, and associate interpretations to justify your conclusions or recommendations.

Activity
1. Explain the importance of analysing research data?

2. Describe methods that one can use to analyse research data?







[bookmark: _Toc360318316]Lesson 8 – Using Ms Excel 2010 to analyse data

A spreadsheet is the computer equivalent of a paper ledger sheet.  It consists of a grid made of columns and rows.  It is an environment that can make number manipulations easy and straightforward.  Microsoft (MS) Excel is a spreadsheet application that is part of Microsoft Office. It enables the calculation and display of complex mathematical formulas (functions) with a facility for extensive formatting. Functions are predefined calculations that may be included in any given Excel cell to perform specific manipulation of data. Using MS Excel, data may be imported from a variety of sources. Analyzing data is a very important skill of any professional, especially those who work in the fields of agriculture and natural resources where data in its raw collected state have very little use without some sort of processing. As a student and a professional, MS Excel can assist you in the analysis of data.  This section focuses on introducing the basic features of MS Excel 2010 to analyze general data.  It will cover the basic steps of creating a spreadsheet, using formulas and basic formatting, and creating charts.
[bookmark: Overview]Overview
Before you start using this MS Excel tutorial, it is very beneficial for you to become familiar with the basic features of MS Excel workbooks and worksheets.  In MS Excel, a workbook is the file in which you work and store your data.  Because each workbook can contain many sheets, you can organize various kinds of related information in a single file.  Worksheets are used to list and analyze data. You can enter and edit data on several worksheets simultaneously and perform calculations based on data from multiple worksheets.  When you create a chart, you can place the chart on the worksheet with its related data or on a separate chart sheet.  The names of the worksheets appear on tabs at the bottom of the workbook window.  To move from one sheet to another, click the desired sheet's tab.
As you can see, we have already used the terms "spreadsheet" and "worksheet".  Although people generally use the two terms interchangeably, the term worksheet refers to the row-and-column matrix sheet on which you work upon while the term spreadsheet refers to this type of computer application.
As mentioned earlier, the workbook can contain worksheets and chart sheets.  The following illustration shows a new worksheet in an MS Excel 2010 workbook:
[image: Excel 2007 Initial Screen]
As you can see in the illustration, worksheets are made up of columns and rows.   In a worksheet the "cell" is defined as the space where a specified row and column intersect. Each cell is assigned a name according to its "column" letter and "row" number.  In each cell there may be the following types of data: text (labels), number data (constants), and formulas (mathematical equations that do all the work).
[image: Row 4, Column D]
· Spreadsheets have many mathematical functions built into them.  The most basic operations are the standard multiplication (*), division (/), addition (+), and subtraction (-).  There is an order of operations when you are evaluating a formula.  Formulas are evaluated from left to right.  Expressions enclosed in parentheses are evaluated first followed by exponents, multiplication and division (same level), and addition and subtraction (same level).  MS Excel has many more operators and mathematical operations may also be performed using "functions" (e.g., the "SUM" function).  A brief description of the latter and relevant common functions for summarizing data can be found here.  Advanced MS Excel functions on correlation and regression analysis are also available. 

· Selecting cells is a very important concept of a spreadsheet. We need to know how to reference the data in other parts of the spreadsheet.  When entering your selection you may use the keyboard or the mouse.  We can select several cells together by specifying a starting and a stopping cell.  This will select "all" the cells within this specified block of cells.

· Depending on the task you want to perform in MS Excel, you can use either relative cell references (which are references to cells relative to the position of the formula) or absolute references (which are cell references that always refer to cells in a specific location).  If a dollar sign precedes the letter and/or number, such as $A$1, the column and/or row reference is absolute.  Relative references automatically adjust when you copy the cells while absolute references do not.
Some of the basic functions of MS Excel 2010 will be demonstrated in this section.
[bookmark: Creating_a_Spreadsheet]Creating a Worksheet
This section describes how to create a worksheet and modify it to suit your needs. You will then use formulas and formatting as well as embed a chart.  To insert a new worksheet, follow the following steps:
1. Click the File tab. This takes you to Backstage view.
2. Select New.
3. Select Blank workbook under Available Templates. It will be highlighted by default.
4. Click Create. A new, blank workbook appears in the Excel window.

[image: Creating a new workbook]
When you first open Excel, the software opens to a new, blank workbook
5. Click on the Insert Worksheet icon. A new worksheet will appear.

6. Right-click on the tab for the new worksheet and select "Rename" from the shortcut menu (alternatively, you could double-click the tab to accomplish the same).

7. Type in the name of the workbook and press "Enter" to save the change.

8. To start entering data, click your mouse on the cell and type in the information. You can type words, numbers or dates, as required. 
It's a good idea to put each small piece of information into a separate cell, because Excel treats each cell as a separate unit. Finish entering data into a cell either by pressing Enter, or by moving to one of the cells next to it using the keyboard arrow keys or your mouse.
[image: http://cdn.itproportal.com/photos/entering_data_1_original.jpg]
9. If your column is the wrong size, hover your mouse on one of the borders between two letters. This will cause a black cursor with two arrows to appear. Click and drag the border to make that column bigger (or smaller). You can also use this method to change the size of your rows, in this case, hover your mouse on the border between two numbers to cause the black cursor with two arrows to appear.

10. Once you have typed all your data, Click the File tab.
11. Select Save As or Save
· Save As allows you to name the file and choose a location to save the spreadsheet. Choose Save As if you'd like to save the file for the first time or if you'd like to save the file as a different name. 
· Select Save if the file has already been named
[image: Clicking Save As]

12. Select the location where you wish to save the workbook.
13. Enter a name for the workbook and click Save.

Using Formulas and Functions
Excel can automatically do calculations for you, using Formulas. Using our example sales spreadsheet, we can write a short formula to find the value of each order. The correct answer will always be produced, even if the price or number of units sold change. In this example, the order value is the number of units sold, multiplied by the selling cost. Typing the "=" symbol tells Excel we want to perform a calculation. Then type the name of the first cell you want to multiply, followed by "*" and then the name of the second cell you want to multiply. For our example, to calculate the order value for Amanda, click on cell F5 and type =C5*D5. Excel will highlight each cell you type with a different colour, to help you see which cells you're multiplying.
[image: http://cdn.itproportal.com/photos/excel_spreadsheets_3_1_original.jpg]
Press Return or Enter, then cell F5 will contain the answer to the calculation, "contents of cell C5 multiplied by the contents of cell D5". In our example, the answer is £680. If Amanda sells another two units, we can change the contents of cell C5 to 7, and Excel will automatically recalculate the new order value (£952).
[image: http://cdn.itproportal.com/photos/excel_spreadsheets_4_2_original.jpg]
Tip: Addition, subtraction and division can also be calculated using the same format
· Addition =C5+D5
· Subtraction =C5-D5
· Division =C5/D5
[bookmark: Formatting_Your_Worksheet]Formatting Your Worksheet
Several formatting features are available within MS Excel 2010 to effectively display your data (we are going to only with some basic ones which were also available in the previous versions of MS Excel).  Text and individual characters can be formatted to make them stand out (you can format all of the text in a cell or only selected characters).  You may also rotate text (in a column for example) as well as add borders, colors, and patterns to distinguish among different types of information in a worksheet.  Also, you can use number formats to change the appearance of numbers (including dates and times) without changing the number behind the appearance.  Finally, you can format cells and lists quickly using the "Cell Styles" button from the "Styles" group of the "Home" tab.  Cells could even be formatted as tables using the "Format as Table" button from the "Styles" group.
To demonstrate how to go about formatting a worksheet quickly, please follow the following steps:
[bookmark: _Toc360115172]Formatting Cells
To Change the Font:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the font command on the Home tab. The font drop-down menu appears.
3. Move your mouse over the various fonts. A live preview of the font will appear in the worksheet.
[image: Changing the font]
4. Select the font you want to use.
To Change the Font Size:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the font size command on the Home tab. The font size drop-down menu appears.
3. Move your mouse over the various font sizes. A live preview of the font size will appear in the worksheet.
[image: Changing the font size]
4. Select the font size you want to use.
You can also use the Grow Font and Shrink Font commands to change the size.
[image: The Grow Font and Shrink Font Commands]
To Use the Bold, Italic, and Underline Commands:
1. Select the cells you want to modify.
2. Click the Bold (B), Italic (I), or Underline (U) command on the Home tab.
[image: The Bold, Italic, and Underline Commands]
To Add a Border:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the Borders command on the Home tab. The border drop-down menu appears.
[image: Adding a border]
3. Select the border style you want to use.
You can draw borders and change the line style and colour of borders with the Draw Borders tools at the bottom of the Borders drop-down menu.
To Change the Font Colour:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the font colour command on the Home tab. The colour menu appears.
3. Move your mouse over the various font colours. A live preview of the colour will appear in the worksheet.
[image: Adding a font color]
4. Select the font colour you want to use.
Your colour choices are not limited to the drop-down menu that appears. Select More Colours at the bottom of the menu to access additional colour options.
To Add a Fill Colour:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the fill colour command on the Home tab. The colour menu appears.
3. Move your cursor over the various fill colours. A live preview of the colour will appear in the worksheet.
[image: Adding a fill color]
4. Select the fill colour you want to use.
To Change Horizontal Text Alignment:
1. Select the cells you want to modify.
2. Select one of the three horizontal Alignment commands on the Home tab.
· Align Text Left: Aligns text to the left of the cell.
· Center: Aligns text to the center of the cell.
· Align Text Right: Aligns text to the right of the cell.

[image: Aligning Text Left]
To Change Vertical Text Alignment:
1. Select the cells you want to modify.
2. Select one of the three vertical Alignment commands on the Home tab.
· Top Align: Aligns text to the top of the cell.
· Middle Align: Aligns text to the middle of the cell.
· Bottom Align: Aligns text to the bottom of the cell.
[image: Top Aligning Text] 
By default, numbers align to the bottom-right of cells and words or letters align to the bottom-left of cells.
Formatting Numbers and Dates
One of the most useful features of Excel is its ability to format numbers and dates in a variety of ways. For example, you might need to format numbers with decimal places, currency symbols ($), percent symbols (%), etc.
To Format Numbers and Dates:
1. Select the cells you want to modify.
2. Click the drop-down arrow next to the Number Format command on the Home tab.
[image: Accessing Number Format commands]
3. Select the number format you want. For some number formats, you can then use the Increase Decimal and Decrease Decimal commands (below the Number Format command) to change the number of decimal places that are displayed.
Working with Cells
To Copy and Paste Cell Contents:
1. Select the cells you wish to copy.
2. Click the Copy command. The border of the selected cells will change appearance.

[image: Copying selected cells]
3. Select the cell or cells where you want to paste the content.
4. Click the Paste command. The copied content will be entered into the highlighted cells.

[image: Pasting selected cells]

To Cut and Paste Cell Content:
1. Select the cells you wish to cut.
2. Click the Cut command. The border of the selected cells will change appearance.
[image: Cutting selected cells]

3. Select the cells where you want to paste the content.
4. Click the Paste command. The cut content will be removed from the original cells and entered into the highlighted cells.
[image: Pasting selected cells]

To Drag and Drop Information:
1. Select the cells that you wish to move.
2. Position your mouse on one of the outside edges of the selected cells. The mouse changes from a white cross [image: Cursor] to a black cross with 4 arrows[image: Cursor].

[image: Positioning the mouse to drag and drop cells]

3. Click and drag the cells to the new location.
4. Release your mouse and the cells will be dropped there.
[image: Dropped cells]

To Use the Fill Handle to Fill Cells:
1. Select the cell or cells containing the content you want to use. You can fill cell content either vertically or horizontally.
2. Position your mouse over the fill handle so that the white cross [image: Cursor] becomes a black cross[image: Cursor].
[image: Positioning the mouse to use the fill handle] 

3. Click and drag the fill handle until all the cells you want to fill are highlighted.
4. Release the mouse and your cells will be filled.

[image: Filled cells]

Filtering and sorting data
To Filter Data:
In this example, we will filter the contents of an equipment log at a technology company. We will display only the laptops and projectors that are available for check-out.
1. Begin with a worksheet that identifies each column using a header row.
[image: Worksheet with header row]
2. Select the Data tab, and locate the Sort & Filter group.
3. Click the Filter command.
[image: Clicking the filter command]
4. Drop-down arrows will appear in the header of each column.
5. Click the drop-down arrow for the column you would like to filter. In this example, we will filter the Type column to view only certain types of equipment.
[image: Filtering a column]
6. The Filter menu appears.
7. Uncheck the boxes next to the data you don't want to view. (You can uncheck the box next to Select All to quickly uncheck all.)
8. Check the boxes next to the data you do want to view. In this example, we will check Laptop and Projector to view only those types of equipment.
[image: Selecting filter data]
9. Click OK. All other data will be filtered, or temporarily hidden. Only laptops and projectors will be visible.
[image: Filtered worksheet]
Filtering options can also be found on the Home tab, condensed into the Sort & Filter command.
Sorting data
Arranging your data alphabetically, from smallest to largest, or other criteria, can help you find the information you're looking for more quickly.
To Sort in Alphabetical Order:
1. Select a cell in the column you want to sort by. In this example, we will sort by Last Name.
[image: Selecting a column to sort]
2. Select the Data tab, and locate the Sort and Filter group.
3. Click the ascending command [image: sort ascending] to Sort A to Z, or the descending command [image: sort ascending] to Sort Z to A.
[image: Sorting in ascending alphabetical order]

4. The data in the spreadsheet will be organized alphabetically.
[image: Sorted by last name, from A to Z]
Sorting options can also be found on the Home tab, condensed into the Sort & Filter command.
To Sort in Numerical Order:
1. Select a cell in the column you want to sort by.
[image: Selecting a column to sort]
2. From the Data tab, click the ascending command [image: sort ascending] to Sort Smallest to Largest, or the descending command [image: sort ascending] to Sort Largest to Smallest.
3. The data in the spreadsheet will be organized numerically.
[image: Sorted by homeroom number, from smallest to largest]
To Sort by Date or Time:
1. Select a cell in the column you want to sort by.
[image: Selecting a column to sort]
2. From the Data tab, click the ascending command [image: sort ascending] to Sort Oldest to Newest, or the descending command [image: sort ascending] to Sort Newest to Oldest.
3. The data in the spreadsheet will be organized by date or time.
[image: Sorted by payment date, from oldest to newest]

Activity
Explain the importance of using MS Excel to record and analyse research data.
[bookmark: Embedding_a_Chart]


[bookmark: _Toc360318317]Lesson 9 – Creating charts to present research data
In MS Excel, you can easily create an embedded chart to present your research results.  After the chart is created, it could be readily modified and even saved as a chart sheet.  In order to create a chart, you need to first select the cells that contain the data you want to appear in the chart.  If you want the column and row labels to appear in the chart, include the cells that contain them in the selection.  Then, you may click the "Insert" tab and then choose a desired chart type by clicking on its corresponding button from the "Charts" group.  The steps to follow are straightforward.
To demonstrate how to go about embedding a chart in your worksheet, please follow the following steps:
To Create a Chart:
1. Select the cells that you want to chart, including the column titles and the row labels. These cells will be the source data for the chart.
[image: Selecting cells]
2. Click the Insert tab.
3. In the Charts group, select the desired chart category (Column, for example).
[image: Selecting the Column category] 
4. Select the desired chart type from the drop-down menu (Clustered Column, for example).
[image: Selecting a chart type]
5. The chart will appear in the worksheet.
[image: The new chart]
Once a chart is selected, a contextual set of tabs appears to enable you to alter the chart "Design", "Layout", and "Format".  The "Layout" tab can be readily used to (among other things) enter a title for the chart, x-axis label, and y-axis label.  You may also format any of the axis as you see fit.



[bookmark: _Toc360318318]Lesson 10 – Concluding a research

After analysing the data collected, a conclusion can be made. A conclusion is like the final chord in a song. It makes the listener feel that the piece is complete and well done. The same is true for your audience. You want them to feel that you supported what you stated in your thesis. You then become a reliable author for them and they are impressed by that and will be more likely to read your work in the future. They may also have learned something and maybe have had their opinion changed by what you have written or created!
How to Write a Research Paper Conclusion
· echo your introduction
· restate your key research statement, making it more and more general
· recapitulate your major ideas
· explain your reader why your research is meaningful
· show the results of your work
· make the reader think of your topic’s importance
· challenge the reader by posing a question
· write a warning or hypothesis
· introduce a relevant quote
· tell an appropriate anecdote


[bookmark: _Toc360318319]Lesson 11 – Using Ms PowerPoint and Ms Word 2010 to present a research


In order to present the research to his or her audience, a researcher can use Ms PowerPoint or Ms Word 2010 (if the audience need a physical detailed report).

MS POWERPOINT IN PRESENTATIONS
"PowerPoint" refers to Microsoft PowerPoint, a program that allows the user to design a presentation that consists of multiple slides. These slides may contain images, text, video clips, and related types of information. PowerPoint is useful for delivering a speech, because the user can utilize text on the screen to remind him or herself of the information to be conveyed to the audience or to summarize his/her dialogue into more manageable and "friendly" sizes, as well as to entertain or explain graphs, charts, and related data.

Creating PowerPoint Presentation
You create your PowerPoint presentation on slides. You use layouts to organize the content on each slide. PowerPoint has several slide layouts from which to choose. Themes are sets of colours, fonts, and special effects. Backgrounds add a colored background to your slides. You can add themes and backgrounds to your slides. After you complete your slides, you can run your presentation. In this lesson you learn how to create slides, makes changes to slides, apply a theme and run a slide show.

Creating a New Presentation
1. Click the File tab. This takes you to Backstage view.
2. Select New.
3. Select Blank presentation under Available Templates and Themes. It will be highlighted by default.
4. Click Create. A new, blank presentation appears in the PowerPoint window.
[image: Creating a new presentation]
The default slide that appears when you create a new presentation is a Title Slide layout.
About Slide Layouts
A slide layout is a predefined style in which you can enter text, graphics, clip art and pictures. PowerPoint provides a variety of slide layouts from which you can choose.
[image: Slide Layout]
Procedures:
1. Under the Home tab, in the Slides group, click on the down arrow next to the Layout button.
2. Click the desired Slide Layout.
To Insert Text into a slide:
· Click inside the slide. The placeholder text will disappear and the insertion point will appear.
· Type your text once the insertion point is visible. 
· Click outside the slide when you have entered all your text into the placeholder. 

To Insert a New Slide:
· Click on the New Slide button on the Home tab of the ribbon to add a new slide to your presentation. 
· Choose a slide layout that suits your needs from the samples shown
[image: Choose one of the new slide layouts in PowerPoint 2010]
To Change the Layout of an Existing Slide:
· Click the Layout button on the Home tab of the ribbon. This will show a contextual menu of the nine different slide layout choices in PowerPoint 2010.
· The current slide layout will be highlighted. Hover your mouse over the new slide layout of your choice and that slide type will also be highlighted. When you click the mouse the current slide takes on this new slide layout.
[image: Change PowerPoint 2010 slide layouts]

[bookmark: _Toc360061389]Working with Slides
To Copy and Paste a Slide:
· On the Slides tab in the left pane, select the slide you wish to copy.
· Click the Copy command on the Home tab. You can also right-click your selection and choose Copy.
[image: Copy command]

· In the left pane, click just below a slide (or between two slides) to choose the location where you want the copy to appear. A horizontal insertion point will mark the location.

· Click the Paste command on the Home tab. You can also right-click and choose Paste. The copied slide will appear.
To Delete a Slide:
· Select the Slide to be deleted
· On the Slides tab of the Slides / Outline task pane on the left of your screen, click on the thumbnail of the slide you wish to delete. 
· Press the Delete key on your keyboard.

[bookmark: _Toc360061390] To Move a Slide:
· Select the slide you wish to move.
· Click, hold, and drag your mouse to a new location. A horizontal insertion point will mark the location.
· Release the mouse button. The slide will appear in the new location.

Change the Background Style or Format your Background:
When you want to format the background for one slide or for all the slides you can change the Background Style or Hide Background Graphics under the Design tab, in the Background group. To remove your background graphic, click on the checkbox next to the Hide Background Graphics feature in the Background group.
[image: Design Tab, Background group]
To change your background style, you can click on the Background Styles button under the Design Tab, in the Background group. When you click on the button the Background Styles gallery displays, and you can choose your style.
You can point to each of the background styles to view the style on your slide, and you can right-click on the style to display the shortcut menu. You can click on Apply to Selected Slides or Apply to All Slides.
[image: Background Styles gallery]
When you click on the Format Background... feature or the Dialog box Launcher button [image: Dialog Box Launcher] on the bottom right corner of the Background group, you will get the Format Background dialog box as shown below. With one slide selected, you can choose the Fill or Picture option button and change the format. Once you click on the Close command button, your changes takes place to the current slide, or if you want to format the background of all of the slides, then click on the Apply to All command button.

Adding an Image
Even if you customized the background, you might also want to add an image - like a logo - that appears on every slide.  To do this, click on the Insert tab and click Picture to select a picture from your computer.

Choosing a Colour Theme
You can choose a colour theme under the Colours tab.   Even if you don't yet have any colored elements on your master slides, this theme will ensure that Smart Art, Charts, and Shapes added to the final presentation better match your layout.
You can also add notes to your presentation.

[bookmark: _Toc360061393]Saving Your Presentation: 
If you are saving a document for the first time, you will need to use the Save As command; however, if you have already saved a presentation, you can use the Save command.
To Use the Save As Command:
Save As allows you to choose a name and location for your presentation. It's useful if you have first created a presentation or if you want to save a different version of a presentation while keeping the original.
1. Click the File tab.
2. Select Save As.
[image: Save As]
3. The Save As dialog box will appear. Select the location where you wish to save the presentation.
4. Enter a name for the presentation and click Save.
[image: The Save As dialog box]
To Use the Save Command:
1. Click the Save command on the Quick Access Toolbar.
[image: Saving a presentation]
2. The presentation will be saved in its current location with the same file name.
If you are saving for the first time and select Save, the Save As dialog box will appear.
[bookmark: runpowerpoint]Run Your PowerPoint Slide Show
After you create your slides, you can run your slide show:
To Start Slide Show:
1. Select the Slide Show tab.
2. Click the From Beginning command in the Start Slide Show group to start the slide show with the first slide.
[image: Starting Slide Show ]
You can also start the slide show from the slide you prefer by selecting the slide and clicking on From Current Slide from the Start Slide Show group. This option is convenient if you only want to view or present certain slides.
Another option for starting the slide show is to select Slide Show view at the bottom of the window.
 [image: Starting Slide Show view option]
To Advance and Reverse Slides:
1. Hover your mouse over the bottom right of the screen. A menu will appear.
2. Click on the right arrow to advance slides or click on the left arrow to reverse slides.
You may also use the arrow keys on your keyboard to advance and reverse slides.
To Stop or End Slide Show:
To end slide show, hover and select the menu box options command and click End Show. You can also press the "Esc" key at the top left of your keyboard to end show. 

 USING MS WORD 2010 WHEN PRESENTING RESEARCHES
Microsoft Word is the world’s leading word processing application. It can be used to work with a wide range of documents from simple letters, memos to complex documents like newsletters, forms and now with blogs too with Word 2010.

Some of the advantages of using Ms Word 2010 in presenting research results include;
· Information editing 
· Documents typed can be printed
· Pictures and graphical presentations can be pasted
· Information can be copied and pasted from one source to the other.
· Formatting can be done
· Information can be saved for future use.
· Word documents can be attached and sent via emails to target audience.

	
LEARNING ACTIVITY 3


You are now required to present the results of your research in front of your class and facilitator using computer technology. Ensure that,  

· The presentation is made using the computer application you identified in the research plan. 

· The presentation communicates summarised research data and conclusions to the target audience 
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